
Help supports most of the character and paragraph formatting features supported 
in Word for Windows. However, because Help topics are displayed online in 
windows whose sizes vary dynamically when the user changes the window’s 
size, Help’s display differs from the printed page produced by Word for 
Windows. Help also creates a number of formatting anomalies when translating 
Word’s paper orientation to the online medium.

This chapter explains how to format the text and graphics you place in Help 
topics and describes the character and paragraph formatting features Help 
supports. If a formatting feature in Word for Windows is not discussed in this 

chapter, it isn’t supported.

Windows Help redefines a number of Word for Windows features so that they 
have a different meaning in Help topic files than they do in a normal word-
processing document. Learning to create Help topics is in part a matter of 
learning to apply standard word-processing conventions in some unconventional 
ways. The remainder of this chapter provides some quick-reference information 
that you can refer to as you are learning how to create topic files. 

Character Formatting

Help topic files can include most types of Word for Windows character 
formatting. The following sections describe the character formatting properties 
that Help supports.

Fonts
Help supports multiple fonts and font sizes. Help attempts to match the typeface, 
type family, and size that the author specifies in the Help file. Font information is 
passed to the Windows font manager without special processing. 

Topic layout within the Help window is based on screen fonts rather than printer 
fonts. Because most word processors perform their screen layout based on the 
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installed printer, the layout in the word processor may not match exactly the 
layout in Help. 

The following screen fonts are available on all Windows version 3.1 systems:

n Courier 10,12,15
n Modern
n MS Sans Serif 8,10,12,14,18,24
n MS Serif 8,10,12,14,18,24
n Roman
n Script
n Small
n Symbol 8,10,12,14,18,24

Windows version 3.1 also includes the following TrueTypeTM fonts:

n Arial®

n Arial Bold
n Arial Bold Italic
n Arial Italic
n Courier
n Courier Bold
n Courier Bold Italic
n Courier Italic
n Times New Roman®

n Times New Roman Bold
n Times New Roman Bold Italic
n Times New Roman Italic
n Symbol

In many cases, the TrueType fonts provide better scaling and presentation quality
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than the raster or vector fonts used with Windows. If you have users with 
Windows version 3.0, however, they will not have any TrueType fonts on their 
system.

In addition to the standard Windows fonts, you can define custom screen fonts to 
ship with your Help file. If you don’t ship all your fonts with the Help file, there’s
a chance that the fonts on the user’s system won’t match the fonts available in 
your Help font. When a requested font is unavailable, Help lets Windows 
determine a compatible font to use. The Windows font-mapping function usually 
produces a good match, but in some cases fonts might look quite different. To 
avoid font mismatches, you should ship any custom fonts with your Help file or 
use just the standard Windows fonts.

Hint

If you are using Word for Windows, you should cancel the 
Display As Printed option (version 1.1) or the Line Breaks And Fonts 
As Printed option (version 2.0) because Help doesn’t use printer fonts. 
This option causes Word to display fonts as they will appear on the 
printed page. If you clear this option, your Help topics in Word will 
more closely match the way they appear in Help.

Special Fonts

Help does not accept characters from “special” or nonstandard fonts because RTF
does not really identify them well. Windows Help assumes that text has priority 
and that all fonts use the ANSI character set. The “symbol” font is special-cased 
as a SYMBOL font, but there are no other exceptions. The Zapf Dingbat font is 
supported because it is treated as a symbol font. Nonstandard characters are not 
allowed.

Special Characters

Many TrueType fonts, such as Times New Roman, have special characters for 
basic typesetting symbols, and Help can display these symbols. The problem is 
that when Word saves a document in RTF format, it converts selected symbols to 
special RTF tags: 
opening single quotation mark \lquote
closing single quotation mark \rquote
opening double quotation mark \ldblquote
closing double quotation mark \rdblquote
bullet \bullet
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em dash \emdash
en dash \endash

Help ignores Word’s RTF tags and displays nothing in their place. For example, 
special characters such as Word’s bullets don’t show up in compiled Help files.

Other “special characters,” such as the trademark symbol, do not have special 
RTF tags; instead, Word saves them as \’hh codes, which specify a hexadecimal 
character number. These are displayed correctly in Help. So if you want to use 
special characters in your Help file, you can edit the RTF topic files before 
compiling and replace the Word RTF tags with the appropriate \’hh codes: 
\lquote ==> \'91 
\rquote ==> \'92 
\ldblquote ==> \'93 
\rdblquote ==> \'94 
\bullet ==> \'95 
\endash ==> \'96 
\emdash ==> \'97 

Each of the search targets has a trailing space, so be sure to include in your 
search, but don’t include a space after the replacement string. 

Hint

Don’t use Word’s Insert Symbol command to insert special 
characters: it inserts symbol fields, which the Help compiler doesn’t 
recognize. Instead, use the Windows Character Map application to copy
the character to the Clipboard. Then paste the character into your topic.

Hint

Although Help doesn’t support many special characters, it does 
support the nonbreaking space (CTRL+SHIFT+SPACE).

Bold text
Help uses the Windows default boldness, which is achieved by doubling the 
pixels that make up the font. In most cases, this creates a bold that is darker and 
higher in contrast than the bold in printed text.
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Italic text
Italic text is supported, but it is generally difficult to read online. Help adds white 
space on the right edge of italic text to achieve a smoother combination of italic 
and nonitalic text. If you mix both italic and nonitalic text in hot spots (single 
underlines or double underlines), the added white space may cause broken 
underlines.

Small Caps
Although Help supports small Caps, the font you choose may limit its usefulness. 
When rendering small caps in Help, the small caps ascender reaches the baseline 
of normal text, making the text slightly smaller than the small-caps text displayed 
in Word for Windows.

Colored text
You can change the text color to any valid RGB value. However, Help may 
modify the color if the user’s display does not support the authored color or if the 
user’s background color conflicts with the authored color.

Unsupported Character Formatting
Windows Help does not support the following character attributes:

n Superscript and subscript text. If you want to use superscript or 
subscript letters in the Help file, you can define a special font whose 
characters sit above or below the baseline. You can also use bitmaps 
of superscript/subscript characters.

n Expanded and condensed letter spacing.
n All Caps text. To use capital letters in the Help file, just type the text 

in all capitals using the SHIFT key instead of formatting the text as All
Caps.

If you use an unsupported attribute in your topic, Help will fail to display the 
attribute. For example, superscripted text appears as normal text.

Windows Help uses certain character formatting attributes to create hot spots; 
therefore, Help does not support the standard meaning of the attributes. The 
character attributes that Help supports differently from Word for Windows are 
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described in the following table:

Attribute Purpose

Double-underlined or 
strikethrough text

Specifies the hot-spot text that the user will see 
displayed in the Help window. The user can then 
choose this text to make a jump to another topic or to 
execute a macro.

Single-underlined text Specifies the hot-spot text that the user will see 
displayed in the Help window. The user can then 
choose this text to cause a pop-up window to appear.

Hidden text Specifies the context string for the topic that will be 
displayed or the macro(s) that will execute when the 
user chooses the hot-spot text.

Note

For information about using each of these specific formatting 
properties, see Chapter 8, “Creating Links and Hot Spots.”

Using Strikethrough Text in Word for Windows

In Word for Windows version 1.1, deleted text with revision marks is marked 
with the strikethrough property, which in RTF is indicated with the \strike 
statement.

In Word for Windows version 2.0, \strike is used to mark revisions and \deleted 
was added to indicate deleted text with revision marking. So if you save a version
1.1 file as RTF, strikethrough text loses its revision markings but looks the same 
on screen—strikethrough. Conversely, if you save a version 2.0 RTF file that has 
strikethrough text and open it in Version 1.1, the strikethrough text acquires the 
revised \deleted property.

Therefore, if you use strikethrough text to indicate hot spots in your topic files, 
you should not edit the RTF files in both Word for Windows versions (1.1 and 
2.0). Instead, convert all your Version 1.1 files to Version 2.0 by opening them 
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and then saving them as RTF. Or, if you must use both versions of Word for 
Windows, do not use strikethrough or deleted text attributes.

Inserting Superscript and Subscript Characters

Even though Help does not support superscript and subscript character formatting
attributes, you can insert these characters into your Help files using either of two 
workarounds. You can:

n Use a font editor to define a custom superscript/subscript font whose 
characters sit above or below the baseline.

The custom font should be a larger point size than your normal body 
text so that you can place the superscripted/subscripted characters in the
high or low portion of the font character.
n Create bitmaps of the superscript/subscript characters and place them 

in the Help file using bmc references.
Make sure that you save the bitmaps without extra white space around 
them so that they display the same as regular text on-line.

Paragraph Formatting

Help supports most of the major paragraph formatting features of Word for 
Windows, and in most cases paragraphs displayed in the Word document look the
same in Help. The main difference between a Word document and a Help topic is
the display medium: a document is printed on a piece of paper that has a fixed 
size, but a topic is displayed in a window. Window sizes can vary, and in the case
of main and secondary windows the user can change the size of the window after 
the topic has been displayed. Many of the differences between the look of a topic 
in Word and the look of a topic in Help stem from Help’s support for sizeable 
windows.

To support sizeable windows, Help uses a word-wrapping mechanism to ensure 
that paragraph text is not clipped at the right margin. You can disable the word 
wrapping by following the instructions in “Disabling Word Wrapping in 
Paragraphs,” later in this section.

The following sections discuss the paragraph formatting features supported by 
Help. For information on table formatting, see “Table Formatting,” later in this 
chapter.
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Alignment
Help supports the following paragraph alignment attributes:

n Left alignment
n Right alignment
n Center alignment

These attributes have the same meaning as in Word for Windows, except that 
left-justified and right-justified text is justified to the Help window’s internal 
margin of 8 pixels on the left.

Help does not support justified text.

Indents
Help supports the following paragraph indentation attributes:

n Left indents, including positive and negative values.
Left indents are relative to the left window border. Negative values 
position the left margin of the paragraph to the left of the left window 
border.
n Right indents, positive values only.
Right indents are relative to the right window border (or the vertical 
scroll bar, when present). 
n First line indents, including positive and negative values.
Word defines an implied tab stop at the position of the left indent, but 
Help does not provide this tab stop. To tab to the left indent position, 
define a left tab at the same position as the left indent.

Indents have the same meaning as in Word for Windows, but they may have 
different measurement values. Figure 7.1 shows how Word indents are used in 
paragraphs displayed in Help.

Graphic
<Help paragraph. Callouts to show left, right, and first-line indent values>
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The Help window’s 8-pixel margin on the left prevents text from bumping 
against the left window border. You can specify a negative indent to push text or 
graphics closer to the left edge; however, if your negative indent is too large, you 
may push the text off the screen where the user can’t scroll to see it. A negative 
indent of 7 points will move the text to the edge without pushing it beyond the 
window border.

With a negative left indent, you can bleed pictures off the left window border. 
For example, the following topic uses a negative left indent of 3 picas to crop the 
left edge of a picture (Figure 7.2).

Graphic
<Help bleed>

Paragraph Spacing
Help supports all Word paragraph spacing attributes.

The Space Before and Space After attributes add white space before and after a 
paragraph, which is the same function they have in the word processor, but they 
may have different values in Help.

Text displayed in the Help window includes a 3-pixel top margin to prevent it 
from bumping against the button bar. However, bitmaps do not include a margin. 
So if you use a bitmap in the first paragraph of a Help topic, you should include 
space before if you want the picture to have white space around it. Otherwise, the
picture will display immediately below the button bar with no intervening white 
space. This is a helpful technique to use when you want to fill the Help window 
with a picture.

Line Spacing
Help supports two kinds of line spacing: Auto and Absolute (or exact). Automatic
line spacing (marked with Auto, Single, 1.5, or Double line-spacing attributes) 
creates a variable line spacing that is determined partly on the height of the 
largest character (or bitmap treated as a character) within the line. Auto line 
spacing ensures a safe spacing that adjusts to the content of the paragraph. 
However, Help’s method for determining the appropriate spacing for an 
automatically spaced line doesn’t take into account line length, color, and other 
attributes that can affect the legibility of a paragraph.

Absolute or exact line spacing is determined by the author and is set to the 
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absolute value specified. Absolute line spacing is used when the author wants 
more control over the way paragraphs appear in Help. It can be used to add white
space and create more openness, or it can be used to reduce the white space 
between lines and tighten up the paragraph. If you want to condense or expand 
the line spacing in a paragraph, use the Exactly line spacing attribute, and specify
a point size for the line. Or, if you are using Word for Windows 1.1, specify the 
exact line spacing that you want, but use a negative value to indicate that the 
spacing is “absolute” or “exact.”

Tabs
Help supports the following types of tab stops:

n Left-aligned tabs
n Right-aligned tabs
n Center-aligned tabs
n Default tab stops (up to 32)

Although Help supports these tab stops, very complex combinations of alignment 
and tabs may not appear the same in Help as they do in Word for Windows.

Help does not support leader characters or decimal tabs. Decimal tab stops are 
treated as left tab stops.

In paragraphs with first-line indents, Word defines an implied tab stop at the 
position of the left indent. Help does not provide this tab stop. To tab to the left 
indent position, define a left-aligned tab at the same position as the left indent.

If you include embedded windows in your Help file, do not use right-aligned or 
center-aligned tabs to position the embedded window. Use indents instead.

In many cases, Word tables are more flexible and easier to use than tabbed 
paragraphs. For information on using tables, see “Creating Tables,” later in this 
chapter.

Using Paragraph Borders
Help supports the following paragraph borders:

n Any combination of left, right, top, and bottom borders, including 
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boxed paragraphs (all four borders)
n Thin single borders (1 pixel wide)
n Thin double borders (each line 1 pixel wide)
n Thick single borders (2 pixels wide)

Figure 7.3 shows which line-width choices in the Word for Windows version 2.0 
Border Paragraphs dialog box translate to the supported border types (thin single, 
thin double, and thick single).

Graphic
<Word Border Paragraphs, circles/callouts identifying which line values produce 
which border types>

Help does not support the following border attributes:

n Colored borders (Help draws all borders in black)
n Shadowed borders
n Hairline borders
n Adjustable distances from text
n Paragraph shading or background coloring
n Table-cell borders (set in the Border Cells dialog box)

Paragraphs inside tables can have borders, but the table itself cannot have 
borders. For more information, see “Table Formatting,” later in this chapter.

Word combines border attributes in consecutive paragraphs. For example, if two 
consecutive paragraphs have a boxed border, Word draws a single box around 
both paragraphs rather than drawing boxes around the individual paragraphs. 
Help does not combine border attributes of consecutive paragraphs; for 
consecutive boxed paragraphs, Help draws individual boxes around each 
paragraph.

Disabling Word Wrapping in Paragraphs

By setting the Keep Lines Togetherparagraph attribute, you can prevent Help 
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from word-wrapping a paragraph. When the window border is sized inside the 
right boundary of the paragraph, Help adds a horizontal scroll bar and clips the 
right edge of the paragraph. If the paragraph is several lines long, you’ll need to 
place forced line breaks where you want the lines to break.

To prevent a paragraph from wrapping

1. Place the insertion point anywhere in the paragraph.
2. From the Format menu, choose Paragraph.
The Paragraph dialog box appears.
3. In the Keep Paragraph box (Word 1.1), select Together.
Or, in the Pagination box (Word 2.0), select Keep Lines Together.
4. Choose OK.

To create a line break in a nonwrapping paragraph

1. Place the insertion point where you want the line to break.
2. Press SHIFT+ENTER.

Note

Windows Help does not support the standard meaning of the 
Keep With Next paragraph attribute. In Help, this property specifies 
that the paragraph should be included in the nonscrolling region of the 
Help window. For information about using this formatting property, see
Chapter 9, “Defining Topic Windows.”

Unwanted Line Breaks

Because Windows Help treats any font or style change as a word break, 
punctuation characters may wrap to a new line and become orphaned from the 
sentence they belong to if they follow a hot spot or a bitmap reference. In these 
cases, the punctuation character follows Help codes that require format changes 
(from double-underline to hidden text to normal text, for example). Because of 
the format change, Help treats the transition as a word break and wraps the 
trailing punctuation when necessary (depending on how the user resizes the Help 
window).

To prevent this from occurring in your Help file:
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n If the punctuation follows a hot spot, include the punctuation mark in
the hot spot (before the hidden text).

n If the punctuation follows a bitmap reference, use a nonbreaking 
space between the bitmap reference and the punctuation mark.

Table Formatting

Tables are flexible and powerful formatting tools for Help topics and are the 
easiest way to create complex arrangements of text and graphics. They are 
particularly useful for positioning embedded windows in ways not supported by 
the basic Help alignment attributes.

Help lets you create left-aligned tables using any combination of rows and 
columns. You can place any type of topic information, including text and 
embedded windows, in table cells. Help wraps paragraph text inside tables, but it 
doesn’t change the word wrapping of table paragraphs when the window is 
resized. The table is a fixed object, and its width remains constant as the window 
is sized. If the right window border clips the right side of the table, Help displays 
a horizontal scroll bar to let the user scroll the hidden information into view.

Help supports the following table formatting attributes:

n Left-aligned tables
n Variable column width and inter-column spacing
n Left indent for the table
n Inter-row spacing (using paragraph spacing attributes)
n Merged cells

Paragraphs inside tables can use any of the paragraph formatting attributes 
described in “Formatting Paragraphs,” earlier in this chapter.

Help does not support the following Word table features; the Help compiler 
displays a “Table formatting too complex” message if it encounters unsupported 
table features in a topic:

n Cell borders (although paragraphs inside tables can use borders)
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n Custom row heights
n Right-aligned and center-aligned tables

Note

If you apply a border to a paragraph contained in a table, Help 
applies the border to the table cell, not the paragraph. To use paragraph 
borders inside tables, you must either apply the border to the paragraph 
style or apply the border to the paragraph before moving it into the 

table.

In Windows Help version 3.1, you can create simple tables (tables without 
borders or shadows) using the table formatting features in Word for Windows. In 
Word for Windows, a table is simply a collection of paragraphs that have been 
divided into individual cells. The Help compiler interprets these tables as a type 
of side-by-side paragraph formatting and displays them in the Help window.

You can author a table either as fixed width or relative.

Creating Fixed-Width Tables

A fixed-width table is one that appears in Help exactly the way you create it. In 
other words, the table retains the original width when displayed in Help, no 
matter how the user resizes the window. 

To create a fixed-width table

1. Place the insertion point where you want to insert the table.
2. From the Insert menu, choose Table (Word 1.1).
Or, from the Table menu, choose Insert Table (Word 2.0).
The Insert Table dialog box appears.
3. Type the number of columns and rows you want.
Or, if you’re not sure what your requirements are, you can accept the 

Creating Tables
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default settings and make the appropriate additions and changes later.
4. Choose OK.
5. Type the information in each of the cells.
Figure 7.4 shows a two-column table in a topic file.

Graphic

Creating Relative Tables

Help also supports relative or “autosized” tables. Unlike fixed-width tables, the 
columns in relative tables wrap dynamically when the user resizes the Help 
window. However, the columns in relative tables will only maintain their relative 
widths down to a minimum size. After that, they will not wrap. The minimum 
size is determined by the author who creates the table.

Relative or autosized tables are created by making the table rows centered. 
However, the procedure is different depending on which version of Word for 
Windows you are using. In Word for Windows version 1.1, you create centered 
tables by using the Format Table command.

To create a relative table using Word for Windows 1.1

1. Create a standard table.
2. From the Format menu, choose Table.
The Format Table dialog box appears.
3. Select the Align Rows Center option button.
4. Select Apply To Whole Table, and then choose OK.
Word for Windows version 2.0 does not have a Format Table command, so if you
create a centered table using a frame and the Format Frame command, Word 
does not generate the correct RTF for the Help compiler to create an autosized 
table. To create the table in Word 2.0, use the Row Height command.

To create a relative table using Word for Windows 2.0

1. Create a standard table and select all the rows.
2. From the Table menu, choose Row Height.
The Row Height dialog box appears.
3. Under Alignment, select the Center option button.
4. Choose OK.
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Setting the Minimum Width
The authored column widths are the minimum widths that will be displayed. 
Windows Help will make the table larger to fit a larger window, but it will not 
wrap it smaller. If the window is sized smaller than the authored table, the 
window displays horizontal scroll bars. Therefore, you must author the table at 
the smallest size that you want it to take in the window. For example, if you want 
it to wrap small, you should create the table at its smallest size, like this:
This This
text text
is in is in
the the
first second
column. column.

Windows Help sizes each column proportionally, but Help will not break words 
within the table to create nice text blocks. Windows Help does not understand 
optional hyphens or word breaking at all. So you are responsible for creating the 
right margin you want in this small size.

Adjusting the Table Columns
When you size table columns in Word for Windows, you can use three different 
methods. Using methods two and three allow you to reset the right column border
to its former position after sizing the table:

n If you size by dragging a column border, columns to the right are 
shifted horizontally, but their width remains the same. The result is 
that the right boundary of the table changes position.

n If you hold down the SHIFT key before dragging the column border, 
the column immediately to the right is sized, but its right border stays
the same.

n If you hold down CTRL before dragging the column border, all 
columns to the right are sized proportionally, and the right boundary 
of the table stays the same.

Creating Tables Without Using Word’s Table Feature

Because Windows Help version 3.0 does not support tables, you must use 
alternative methods to create tables. There are three ways to create tables without
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using the table feature in Word for Windows:

n Use a hanging indent to place short pieces of text in the beginning 
column(s) and longer text pieces in the final column.

As the user resizes the window, the text in the “outside” column wraps 
to accommodate the new window size.
n Use Word for MS-DOS or Word for the Macintosh to create side-by-

side paragraphs.
Using this method, you can create tables with only two columns.
n Format the table manually using tab stops, and then format the entire 

table as “nonwrapping” to keep the table intact when the user resizes 
the Help window.

Hanging Indent Tables
The easiest way to create a simple table without the table feature is to use a 
hanging indent. The hanging indent creates the first column and forces the text in 
the second column to wrap to the indent.
First column The hanging indent creates the first column. Text in the second

column starts at the tab stop and wraps to fit the current window
size, regardless of how wide it is in the topic file.

You can also create hanging indent tables with more than two columns as long as 
the information in the first columns is short.
First column Second column The hanging indent and tabs create the first and

second columns. Text in the third column starts
at the second tab stop and wraps to fit the
current window size, regardless of how wide it 
is in the topic file.

Hanging indent tables have limited uses, but they work best when there are only 
two or three columns and the text in the first columns is short enough to fit on one
line without wrapping. To have a hanging indent table appear correctly in Help, 
you must use a tab stop at the beginning of the table’s left margin (where the 
wrapping column begins). You can use hanging indent tables in Help versions 3.0
and 3.1.

To create a table using a hanging indent

1. Type the text for the first column, press TAB, type the text for the 
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second column, and then press ENTER.
2. Repeat step 1 until you have created all the rows in the table, 
including the table heading.
3. Select all the paragraphs in the table.
4. Hold down the SHIFT key while dragging the left (bottom) indent 
marker to the position you want for the left indent.
5. Insert a tab stop at the same location where you placed the left indent
marker.
Note     If you want more precision, you can choose the Format 
Paragraph command and type in the measurements for the left indent, 
first line indent, and tab stop.
Note     The style sheet in the WHAT30.DOT and WHAT31.DOT Help
Authoring Templates includes two styles, “Th” and “Tp,” that you can 
use to create hanging indent paragraphs automatically.

Figure 7.5 shows a two-column table created with a hanging indent.

Graphic
Side-By-Side Paragraphs
To create tables with similar amounts of text in each column, you can use Word 
for MS-DOS or Word for the Macintosh version 3.x. Refer to the documentation 
accompanying these products to learn how to create side-by-side paragraphs.

Note

Windows Help version 3.1 no longer supports side-by-side 
paragraph formatting. You can display a Help file that contains side-by-
side paragraphs only if the file was built with the Help 3.0 compiler. To
build the file using the Help 3.1 compiler, you must convert any 
information that uses that format into a Word table or paragraphs with a
hanging indent. If you open the old topic files in Word for Windows, 
Word converts the side-by-side paragraphs into table format 
automatically.

Manually Formatted Tables
To create more complicated tables than hanging indents allows, or if you cannot 
create side-by-side paragraphs because you don’t have Word for MS-DOS or 
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Word for the Macintosh, you can format the tables manually using tab stops. The 
tab stops align the text into columns as shown below:
First column text Second column Text in the third column cannot wrap
is built up line by text is kept to because each line in the table is a
line with a strict a strict column separate paragraph.
column width. width also.

Each column in a manually formatted table is a separate paragraph, so the entire 
table should be formatted as Keep together to keep the table rows from wrapping 
when users resize the Help window. If portions of the table are hidden, Help 
displays a horizontal scroll bar so that users can view the hidden information.

To create a table manually using tab stops

1. Type the text for the first column, press TAB, type the text for the 
second column, press TAB, type the text for the third column, and then 
press ENTER.
2. Repeat step 1 until you have created all the rows in the table, 
including the table heading.
3. Select all the paragraphs in the table.
4. From the Format menu, choose Paragraph.
5. In the Keep Paragraph box (Word 1.1), select Together.
Or, in the Pagination box (Word 2.0), select Keep Lines Together.
6. Choose OK.
Figure 7.6 shows a two-column table created with tabs.

Graphic
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	Using Strikethrough Text in Word for Windows
	Inserting Superscript and Subscript Characters

	n Use a font editor to define a custom superscript/subscript font whose characters sit above or below the baseline.
	n Create bitmaps of the superscript/subscript characters and place them in the Help file using bmc references.

	Paragraph Formatting
	Alignment
	n Left alignment
	n Right alignment
	n Center alignment
	Indents
	n Left indents, including positive and negative values.
	n Right indents, positive values only.
	n First line indents, including positive and negative values.
	Paragraph Spacing
	Line Spacing
	Tabs
	n Left-aligned tabs
	n Right-aligned tabs
	n Center-aligned tabs
	n Default tab stops (up to 32)
	Using Paragraph Borders
	n Any combination of left, right, top, and bottom borders, including boxed paragraphs (all four borders)
	n Thin single borders (1 pixel wide)
	n Thin double borders (each line 1 pixel wide)
	n Thick single borders (2 pixels wide)
	n Colored borders (Help draws all borders in black)
	n Shadowed borders
	n Hairline borders
	n Adjustable distances from text
	n Paragraph shading or background coloring
	n Table-cell borders (set in the Border Cells dialog box)
	Disabling Word Wrapping in Paragraphs
	1. Place the insertion point anywhere in the paragraph.
	2. From the Format menu, choose Paragraph.
	3. In the Keep Paragraph box (Word 1.1), select Together.
	4. Choose OK.
	1. Place the insertion point where you want the line to break.
	2. Press SHIFT+ENTER.
	Unwanted Line Breaks

	n If the punctuation follows a hot spot, include the punctuation mark in the hot spot (before the hidden text).
	n If the punctuation follows a bitmap reference, use a nonbreaking space between the bitmap reference and the punctuation mark.

	Table Formatting
	n Left-aligned tables
	n Variable column width and inter-column spacing
	n Left indent for the table
	n Inter-row spacing (using paragraph spacing attributes)
	n Merged cells
	n Cell borders (although paragraphs inside tables can use borders)
	n Custom row heights
	n Right-aligned and center-aligned tables

	Creating Fixed-Width Tables
	1. Place the insertion point where you want to insert the table.
	2. From the Insert menu, choose Table (Word 1.1).
	3. Type the number of columns and rows you want.
	4. Choose OK.
	5. Type the information in each of the cells.

	Creating Relative Tables
	1. Create a standard table.
	2. From the Format menu, choose Table.
	3. Select the Align Rows Center option button.
	4. Select Apply To Whole Table, and then choose OK.
	1. Create a standard table and select all the rows.
	2. From the Table menu, choose Row Height.
	3. Under Alignment, select the Center option button.
	4. Choose OK.
	Setting the Minimum Width
	Adjusting the Table Columns
	n If you size by dragging a column border, columns to the right are shifted horizontally, but their width remains the same. The result is that the right boundary of the table changes position.
	n If you hold down the SHIFT key before dragging the column border, the column immediately to the right is sized, but its right border stays the same.
	n If you hold down CTRL before dragging the column border, all columns to the right are sized proportionally, and the right boundary of the table stays the same.

	Creating Tables Without Using Word’s Table Feature
	n Use a hanging indent to place short pieces of text in the beginning column(s) and longer text pieces in the final column.
	n Use Word for MS-DOS or Word for the Macintosh to create side-by-side paragraphs.
	n Format the table manually using tab stops, and then format the entire table as “nonwrapping” to keep the table intact when the user resizes the Help window.
	Hanging Indent Tables
	1. Type the text for the first column, press TAB, type the text for the second column, and then press ENTER.
	2. Repeat step 1 until you have created all the rows in the table, including the table heading.
	3. Select all the paragraphs in the table.
	4. Hold down the SHIFT key while dragging the left (bottom) indent marker to the position you want for the left indent.
	5. Insert a tab stop at the same location where you placed the left indent marker.

	Side-By-Side Paragraphs
	Manually Formatted Tables
	1. Type the text for the first column, press TAB, type the text for the second column, press TAB, type the text for the third column, and then press ENTER.
	2. Repeat step 1 until you have created all the rows in the table, including the table heading.
	3. Select all the paragraphs in the table.
	4. From the Format menu, choose Paragraph.
	5. In the Keep Paragraph box (Word 1.1), select Together.
	6. Choose OK.




